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Up to Speed with Microsoft Office Word 2007

Using the Ribbon in Word 2007

TheRibbonis the backbone of the Office 2007 applications and is now your toetrter for creating
adocumentFour tabs remain constant in each of the Office 2007 applications that use the Ribbon
(Word, Excel, and PowerPoint): Home, Insert, Review, and WWeéard 2007 uses several additional
tabs including Page LayowReferencesand Mailing(seeFigure 1). The tab groups and features of

each are outlined in the table below. To reduce clutter, some tabs are shown only when needed. For

example, thdesigntab for headers and footassshown only when you click in a header or footer
area. LikewiseDesignandLayouttabsfor tablesare shown only when you click inside a table

L{n \ H 4] ¥ Document2 - Microsoft Word -8Xx
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= s B z | e | oy | ==~ | === [ g  @AFind~
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Clipboard ™ Font F] Paragraph ] Styles i Editing

Figure 1: The new Ribbon in Word 2007.

Tab ~ Functions
Contains the Clipboard group, Font group, the typical formatting buttons for fontrigpe a
size, bold, italic, color, alignment and so on in the FontRer@dgraplgroups. Options also
available for formattindheading and texdtyles in theStylesgroup. The Editing group holds
the Find and Replace settingisd the object and text selecti@ok
Contains all the things you might want to putadocumen® from cover pagegdables,
Insert tab pictures, chartsSmartArtand text boxes to hyperlinkspokmarksheaders, footerpage
numbers, WordArt, equatiorsd symbols.
Contains many of the options that were found in the File menu and the Page Setup opti
the olderWord programs. This includes: margins, page orientasa@g, and line numbering.
Additional choices available for setting up columns, adding watermarksaaedborders,
adjusting paragraph indentation and line spacing and arranging multiple objects on the
Contains all the tools needs to setup a table of contents, footnotes, citation and bibliogrz

Home tab

Page Layout tab

Referencesab captions, indices and tables of lzarities.

Mailings tab All of the mail merge tools and features you love to use are found here

Review tab Find the spellingk grammarcheckey language toolsand other proofing tools here. Markup
thedocumentwith comments or turn on track changes dndumentprotection.

View tab Make a quick switch to any one of the five views, turrtt@ruler,gridlines,or the document

map,zoom in onpagesor arrange all your opaetocumentsn the window.

If your screen resolution is not set high enoughf you do not have th@/ord 2007 window
maximized, you will not see the full listing of Ribbon todter example, with a higher resolution you
will see all the commands in tlhénksgroup on thénserttab.However,with 800 by 600 resolution,
you will see theLinks button only not the commands in the growge€Figure 2).

In that case, click the arrow on thmks button to display the commands in the group.
Generally, the groups that display only the group nan@elower resolution are those with less
frequently used commands.
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Figure 2: The top image shows the /nsert tab on the Word 2007 Ribbon at a lower resolution. Notice the collapsed
Linksgroup with a small arrow below the group name and the positioning of som e group options. The bottom image
shows the same tab on the Ribbon when displayed at a higher resolution.

If necessary, adjust the screen resolution used with your monitor. Use the maximize button in the upper
right corner of th&Vord window to expand the program so it fills the scraad the Ribbon expands
to full size.

Locating Basic Commands

TheHometab holds the commands most people use frequently ereatingdocuments. This

includes all the options for changing font types, styles, text alignment, line spacing, and setting up
bullet and number listdf you need to change text alignmeatd.,from left aligned to centered), you'l
find the commands for it in tHeéaragraphgroup of theHometab.All keyboard shortcuts you may
have used in previous versions of Word work in 2007.

Thelnserttab contains all of the objects (Word refers to some of them as "lllustrations”) and text
based components that you can add to the docuPage based elements such as headers, footers,
page breaks, page numbering and bookmarks are alsodauhd tab.

ThePage Layoutab contains just about all of the features you need to manage the overall appearance
of thedocumentMost of the options on this tab (margisie line numberingetc.) were located in
the FileA Page Setup menu option akpiousWord versions.

The Proofinggroup found on theReviewtah, holds the familiar spelling and grammar checker,
thesaurus and other language based tools.

To help you findWord 2003 commands in the néWord 2007 interfaceyou can use the interacéiv
command reference guide found on the Microsoft Office web site. The guide maps all the previous
menu commands to their new location in the Ribbon or elsewhere in Word 2007. You can find the
guide at the following web sitéttp://office.microsoft.com/ets/word/HA100744321033.aspx

TIP: If you have thé&etting Startedab installed, you can find the Interactive Guide inRhel a
Commandyroup on this tab.

/ r'l
Additional file level opions (new, open, save, save as, print, close, etc.) can be found by ci. “.ing
theMicrosoft Office Button in the upper left corner of the Word window.
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Default Font and Paragraph Formatting

In Word 2007, fonts and spacing in newly created documents thid&sent than in previous versions

of Word (seeFigure 3). All new documents created in Word 2007 use ei@saibri 11 point or

Cambria 11 pointas the default font and also contain some extra paragraph asgdiciag. The

spacing between lines has been changed from 1.0 to 1.15 and there is slightly more space between
paragraphs. The Word 2007 default style set and fonts were designed-wateen readability in

mind.
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j‘ M 53 Web Layout 5 Q e = /. Times New Roman 12 ~ = A A
e =l outline _ _ == — 3 |||B 7 U - abe x, |2 —
L:;?tzt F;gasdcir:;n = braft Shov\i/Hlde Zo?m Wmvdow Mafros Paste S AlE A o A A | Paragraph St{les Edlt'ng
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On the Insert tab, the galleries include items that are designed t

: overall look of your document. You can use these galleries to insert tat
- cover pages, and other document building blocks. When you create pic
they also coordinate with your current document look.
You can easily change the formatting of selected text in the doc’

look for the selected text from the Quick Styles gallery on the Home ta}
text directly by using the other controls on the Home tab. Most control®
¥ the look from the current theme or using a format that you specify dire®
To change the overall look of your document, choose new Ther

g Layout tab. To change the looks available in the Quick Style gallery, ud
~ Quick Style Set command. Both the Themes gallery and the Quick Sty?
I commands so that you can always restore the look of your document tc}
your current template.

Onthe Insert tab, the galleriesinclude items that are designed td

look of your document. You can use these galleriesto inserttables, head

% and other document building blocks. When you create pictures, charts, ¢
coordinate with your currentdocumentlook.

You can easily change the formatting of selected text in the docu
3 for the selected text from the Quick Styles gallery on the Home tab. You
= using the other controls on the Home tab. Most controls offera choice o
currenttheme or using a format that you specify directly.

To change the overall look of your document, choose new Them
tab. To change the looks available in the Quick Style gallery, use the Char

I command. Both the Themes gallery and the Quick Styles gallery provide &
can always restore the look of your document to the original contained i 2

e}
: ¥ 5 ¥
2 N m [
sedion:1 Page:toft | |[EER I E = LemenC)aniiUs () Sedtion:1 Page:1of1 [BaR 2 === o |

Figure 3: A side-by-side comparison of text in the Word 2007 default font format ( left) and in the Word 2003 default
format (right).

To change the Calibri or Cambria foirngly select the text you want to change and choose an option
from theFont drop down list found in thEontgroup on theHometab of the Ribbon. Adjust the font
size using the drop down list found in thent Sizeoption. This change applies only to thelected

text.

To adjust the line and paragraph spacing simply select the paragraph (triple click the paragraph) and
click the dialog box launcher in the lower right corner ofRlaeagraphgroup found on thélometab.

In the Spacingsection, click the dowarrow next to théfter box until the value i® pt. In theLine
Spacindist, selectSingle Clear the number in thit box. Click the OK buttonThis change applies

only to the selected text.
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Changing the Defaults

You can change the default font am@sing for allhew documents created in Word 2007 so you don't
have to make thehangedisted in the previous section with every new docume€hck the dialog box
launcher in the lower right corner of tRentgroup on theHometab. Change the font, fostyle and

size and click th®efault button in the lower left corner of the dialog box. Click ¥esbutton when
prompted to change all new documents to the new font settings.

To change the default line spacing forralw documents click the dialog bdauncher in the lower

right corner of thé?aragraphgroup found on thélometab. Change thBefore andAfter spacing to
zero. Change the Line Spacing to single and the At: to blank. Clidbafsailt button and then the

Yesbutton when prompted to changkénew documents to reflect the new spacing settings.

Inserting Objects

As stated in a previous section, most of the commands for inserting objects into documents are found
on thelnserttab. Word 2007 has the following groups on lieerttab: Pageslables, lllustrations,

Links, Header & Footer, Text, and Symb¢deeFigure 4). Inside thdllustrationsgroup, there are

five types of objects you can add to a document. Inserting Pictures, ClipArt and Shafteshhaged

much with one exceptionlive searching for clips on Microsoft's web site (see the next section).
SmartArt is an entirely new feature and is one of the best additions to the Office 2007 stiite (see
related section on pags.

'tm,, ¢H )= ¥ Document2 - Microsoft Word =TEEX
29
- Home Insert Page Layout References Mailings Review View Get Started ©
|8 Cover Page ~ j ] j}ﬂ ‘; || y :7:\? nﬂ @, Hyperlink j j j A 2| Quick Parts ~ |2 Signature Line ~ | T Equation ~
_] Blank Page l—’} w — =l 4 Bookmark = L A wordArt - (5} Date & Time €2 Symbol ~
= Table Picture Clip Shapes SmartArt Chart Header Footer Page Text = S
*—=, Page Break v Art - ') Cross-reference v Number ~ Box+y = *$d Object ~
Pages Tables Illustrations Links Header & Footer Text Symbols

Figure 4: The /nsert tab of Word 2007.

Working with Images
Inserting images saved on a flash drive or from your computer's hard drive hasn't changed. Locating

images in the extensive Clip Art gallery has changed if you had not used this feature in the more recent
versions of Word (2003 and 203&). Whenyou look for ClipArt using the task

: : : : : ) lip A v

pane, you are searching Microsoft's Office web site for clips without actually cg;ﬁ:;tfor. *
leaving Word.In previous versions, you had to launch a browser window and|go_ - :
through a series of steps to download clips into the Clipate@. You'llneeda| —
live Internet connection to locate the clips on Microsoft's web site. i

All collections v

1) Click in the document where you want to add the Clip Art image s s s b
Selected media file types 4

2) On thelnserttab, in thdllustrationsgroup, clickClip Art .

3) In theClip Art task panghat appess on the right side of the screem
the Search fortext box, type a word or phrase that describes the clip aft
imagethat youare looking for §eeFigure 5).

4) To narrow your search, do one or both of the folfayvi

e To limit the search results to a specific collectiolClp Art, in the

Figure 5: The Clip Art task
pane.
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Search irist, select the check box next to each collection that you want to search.
¢ To limit the search results to clip @d photographsn theResults should blest, selet
only the Clip Artand Photographsheck boes
5) Click the Go button
6) In the list of results, left click the Clip Art image to insert it into doeumentimages with a
small globe in the lower left corner come directly from Microsoft's web site.

Onee inserted, you can useevampedset of graphics editing and enhancing tools to adjust the
appearance of the imadeee the related section below.

Enhanced Image Editing Tools

You can adjust the appearance of images inserted into a document usirapthesgediting and
enhancing tools. All of the picture formatting options are found on the contextual tab that appears
when you select (click) the imagsegFigure 6). This includes the following options:

e Brightness e Border

e Contrast o Effects

e Color e Arrangement
e Styles e Size

e Shape

The numerous combinations of picture settings you can change allows you to create professional
looking graphics for use in yoalocumentsYou no longer have to use a separate geapdliting
program to design a high quality imadfeyou are unsure of the function of@matting optiorthat is
not listed here, simply holithe mouse pointer over the button (without clicking) anceahanced
ScreenTipwill appear with a short desctipn of theoption Experiment with the options until you find
the right combination of adjustments for the selected image.

C;:.! » H9-0 = Document2 - Microsoft Word Picture Tools =

r@

o
4 Home Insert Page Layout References Mailings Review View Get Started Format

% Brightness ~ 13 Compress Pictures - = = = [} Picture Shape ~ @] T Bringt 1=~
D Contrast - By Change Picture il | edll el ‘ d ~ L& Picture Border ~ | Sé - I3

; 4 - - Position

i’/}; Recolor » 23 Reset Picture T ‘i Picture Effects ~ - LﬁTex‘t Wrapping ~ SA~

Adjust Picture Styles Fl Arrange Size

b ] 6w

rop =[5
Crop T112

SR S R

Figure 6: There are many picture formatting options available on the Formattab under Picture Tools.

' NOTE: The enhanced picture formatting tools are only availab#lsaumentsaved in the neword
® | 2007 format docx). If needkd, convert your oldocumenformats into the new using the option found
in the Microsoft Office Button (upper left corner of the program).
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Compress Images
Inserted images are usually the most common reason for btbatacthensizes. This is especigl
true of images that were taken with a digital camera and not-dia®d outside diVord. The image
compression tool iVord 2007 makes it easy to reduce image file size.
1) Click a picturefoundon apage - -
2) Click theCompress Picturebutton available on &
Formattab under Picture Toals

Compression options:
[V Automatically perform basic compression on save

3) C“Ck theOptiOI‘lS button. v égelete cropped areas of pictures:
4) Click the check box tolmoseE-mail (96 ppi)as the | targetoutput:
target output and click the OK button " Print (220 ppi): excellent quality on most printers and screens

" Screen (150 ppi): good for Web pages and projectors
¢ E-mail (96 ppi): minimize document size for sharing

This will change all the pictures used in yalmcumento an
optimal size. Resave tli®cumenwith a new file name. o | _ conce
Make sure you compress images after inserting new ones &re 7: The Compression Settings dialog box.
after all are assembled in tHecument

Working with SmartArt

A SmartArt graphic is a visual representation of information and ideas. You can create SmartArt
graphics by choosg from among many different layouts to quickly and effectively communicate your
messageSmartArt is useful i'Word 2007documentdecause theseten coriain paragraphsvith

bulleted listsThis new feature gives you easy to use tools for creating aigehpepresentation of a

list, process, cycle, matrix, pyramid, relationship, or hierarchy.

Final Outcome

Figure 8: Sample SmartArt graphics added to a Word document. A Funnel
is listed on the left and a Vertical Equation on the right.

To add a SmartArt graphic tod@cumentfollow these steps:
1) Click in the document where you want to add the SmartArt graphic.
2) On thelnserttab, in thdllustrationsgroup, clickSmartArt . TheChoose a SmartArt Graphic
dialog box appears.
3) From the category list, select All or select a category of SmartArt from the list on the left side.
4) From the gallery on the right side, select a SmartArt graphic.
5) Click the OKbutton and the graphic appears onghgeinside the SmartArt canvas.

St. Josephds Coll ege 6
Technology & Information Services



Up to Speed with Microsoft Office Word 2007

Adding and Editing SmartArt Text and Appearance
When you create a SmartArt graphic, the SmartArt graphic and its attag

Type your text here

e
* Jtem1

Text paneare populated with placeholder text that you ieptace with

your information. At the top of the Text pane, you can edit the text that
appear in your SmartArt graphic. At the bottom of the Text pane, you c4
view additional information about the SmartArt graplsiegrigure 9). If
you do not see the additional information at the bottom, drag the botton
border of the pane downward until the information is in view.

* Jtem 1a
e Item 1b
® Item2

ill
AN

* [tem 2a
e Item 2b

The Text pane appears to the left of a SmartArt graphic. It works like ar
outline that mapsiformation directly to your SmartArt graphic. As you agld— ,
and edit content in the Text pane, the SmartArt graphic is automatically] | o oo ot formaton o stese
updated to reflect the changes. There are two ways to view the Text pajngi=t, freess e norfion. Works uel with
1) Click the flyout handle to the left of the SmartArOR *UL (5] s ok multiple
2) Click theDesigntab undeiSmartArtToolsand click theText Pane | | :
option found in theCreateGraphicgroup.

id

Learn more about SmartArt graphics

Figure 9: The SmartArt Text pane
appears to the left of the graphic.
To add text to a SmartArt graphic using the Text pane, follow these steps:
1) Click the SmartArt graphic to select it.
2) Display the Text pane.
3) Click inside one of the text box areas of the pane and use the following keys to add and remove
entries:
To create a new line of bulleted text in the Text pane, [iress:
To indent a line in the Text pane, prés$to indent orShift+Tabto negativey indent
from within the Text pane.
Use theBackspacandDeletekeys to remove lines of text.
Any of thesekeystrokesupdates the mapping between the bullets in the Text pane and the
shapes in the layout for the SmartArt graphic.
4) To close the text panelick theX in the upper right corner of thext pane.

Word allows you to change many of the design features used in a SmartArt gvaphizan do this by
choosing from different colorsutlines 3-D effects, shape fillgr typesand layoutof SmatArt.

When you click a SmartArt graphic, two contextual tabs appear @martArt Toolon the Ribbon:
DesignandFormat. Both of these tabs hold dozens of features and settings you can adjust to change
the appearance of your SmartArt graplsieef-igure 10). For example, there are groups within the tabs
related td_ayouts Styles ShapesandShapeStyles WordArt Styles andPositioning(arrange and size).

tt':"v \E‘ o) - Document2 - Microsoft Word SmartArt Tools - X
)
/ Home Insert Page Layout References Mailings Review View Get Started Design Format ©
J » Q - 1= 2 9_9 Z::»
& Rightto Left | & Q0+9:=9 || ++ ¢ s N . w| v -
Add o < = o W < Change ’ . . - . \‘) = Reset
Shape ~ ‘AjTe’d Pane Colors ~ g Graphic
Create Graphic Layouts SmartArt Styles Reset
Figure 10: The Designtab under SmartArt Tools.
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Working with Page Layouts

Page Layout Tab

In Word 2@®7, you'll find that thé?age Layoutab contains the majority of the tools you need to setup

the overall appearance of your documents. As mentioned in a previous section, this tab contains most
of the settings from previous versionsvigbrd that were stard in the Filg Page Setup menu option.

You can still get into the familiar Page Setup dialog box by clicking the dialog box launcher in the
lower right corner of th®age Setugroup.Other paragraph related spacing options can be found in

this tab as welas options for arranging objects on a page.

In previous versions of Word, not only was it difficult to add a watermark to a document, but removing
the watermark was even more of a challenge. Now, with just a few clicks Braglee_ayoutab you

can usene of thebuilt-in watermarks from the gallery of choices or add a custom one to a document.
There is also aelectionfor removing the watermark in théatermark option found in thé*age
Backgroundgroup of thePage Layoutab.

Headers and Footers

Adding headers and footers to documents has changed in Wordl2@d&vious versions aiVord,
youmay havewvorked in a dialog box to add a header or fodMord 2007 includes many predesigned
headers or footergalledBuilding Blocks in Word 2007 that youcan insert into your document. Or
you can create a header or footer from scrdiectly in thePrint Layoutview while seeing the rest of
the document

To add headers and footers, follow these steps:

1) On thelnserttab, in theHeader & Footergroup, clck eitherHeader or Footer.

2) Choose one of the predesigned header or fdmiiéating blocks or click theedit Header or
Edit Footer option at the bottom of the gallety add your own texA headerareaappearst
the top of the page (or a footer arethatbottom)and theDesigntab is visible on the Ribbon
under Header & Footer ToolsgeFigure 11).

3) If you did not use one of the building blocks, simplyd in the text you want to repeat at the
top of each prited pag€gor the bottom if you are working in the footeD, click one of the
options from théHeader & Footeror Insertgroups on theDesigntab (currentlate andime,
page numberetc.).

4) To stop working in the header/footer, click Bwse Header an Footer option on theDesign
tab.

Figure 11: The Header area of a document and related Desjgntab on the Ribbon.
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